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1. Introduction

CensusCD 2000 Short Form Blocks is the first product to contain complete Census 2000 Short Form Blocks
data, along with 2000 block map boundaries.

CensusCD 2000 Short Form Blocks incorporates many other value added data items and tools such as
calculating population and their characteristics by distance around a point and customized data and map
extracts. Imagine popping this CD-ROM into your computer and, without any other software, getting instant
maps and fascinating information on your own neighborhood or any of the nation's other geographic areas.

CensusCD 2000 Short Form Blocks is the solution for government business and academic users who need
easy and instant access to area statistics and mapping. For existing GIS users, data and maps can be ex-
ported as ArcView® shape and MapInfo® MID/MIF files. For non-GIS users, thematic mapping, query capability,
and statistical tools are built into a stand-alone sophisticated mapping application that integrates incredibly de-
tailed information. This unique product offers an unparalleled breadth of data and revolutionary technology to
extract, create, and export data and maps for any block and community in the nation.

The on-line help contains additional information about selecting, mapping, and exporting data and boundaries.
Documentation provided by the Census Bureau about Short Form Blocks data that has been compiled into
Census CD 2000 Short Form Blocks is also included. A specific Help section to explain the Map Viewer is
available from both the main Help Contents and the Map Viewer itself.

Copyright 1996-2002 by Geolytics, Inc. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of GeoLytics, Inc. Cen-
susCD is a trademark of GeoLytics, Inc. All other trademarks are the property of their respective holders. CensusCD 2000 Short Form Blocks software
license is a single user version only, and the use of any extracted data or maps is restricted to within your own organization.

You must agree to the End User License Agreement (EULA) for CensusCD 2000 Short Form Blocks during
Setup or the product will not be installed and you will have no right to use the product or resulting data. A copy
of this EULA can be found under the Help menu item. You can view a copy of the EULA in advance, before
purchasing or opening any GeoLytics product, by downloading it from the GeoLytics web site at:
www.geolytics.com

January 7, 2002
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2. Installation

Insert the CensusCD 2000 Short Form Blocks CD disk into your CD-ROM drive

-

2. In the Windows Program Manager, choose Run from the Start Menu
3. Type D:\setup.exe (assuming D is the letter of your CD-ROM drive)
4. Click on OK

5. Follow the on-screen instructions. Note: If you have previously installed CensusCD 2000 Short
Form Blocks, un-install it now

6. When prompted, enter your Name, the name of your Organization, and your Serial Number.
Type the serial number with no spaces or dashes. It is very important that the number is exact.

7. After installation is done, you can start CensusCD 2000 Short Form Blocks at any time by
double clicking on the CensusCD 2000 Short Form Blocks icon or from the Windows “Start”
button.

Note: To operate the program, the original CD must be in the same CD-ROM drive from
which the program was installed. Otherwise, the program will run, but you will receive er-
rors when running reports.

3. Five Steps to produce Files/Maps:

: Selection of File to name the file
Selection of Area to be covered by the file
Selection of Counts to be included
Running and Viewing the file

oowp

Step 3A. Selection of File to name the file

The first thing to do is name your request. You can do this by selecting New under the File menu. If you
omit this step, a file titled “Noname” will be generated for the Request.

©2002 Geolytics, Inc. All rights reserved. Page 3of3 |
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Step 3A. Continued

The File menu commands let you establish a directory or path for naming and saving your output files. It
controls where files will be written and allows you to retrieve previous request parameters.

New Request Used to start a new series of files and controls the path/name of subsequent files -
if you don’t use this function all files will be given the default title of “Noname.*”

Open Request Opens existing, saved requests

Save Request Saves current request parameters

A request tells CensusCD 2000 Short Form Blocks what information you want and how you want it. The Re-
quest File stores information about the Area, Counts, and Filter, which is passed to the CensusCD 2000
Short Form Blocks database programs to produce a file. A request is built interactively by using CensusCD
2000 Short Form Blocks pull- down menus, lists, and dialogs. The request file can be started as "new", saved
for later retrieval, or an existing request file can be opened.

The Request File controls where the file will be written. Changing the drive, directory, or name of the re-
quest file will control where the file is produced. For example, if the request file name is changed to
‘a:myfile.req", then the file can be written as "a:myfile.rpt" (Summary report), "a:myfile.csv" (ASCII), or
"a:myfile.dbf" (Dbase output).

You control where the output files are written and what to call them by selecting New Request File or

Save Request File and changing the request files drive, directory, and/or name. The request file, and the out-
put file you run from it, will be written to the place you have selected.

Step 3B. Selection of Area to be covered by the file

Select Area menu command. You will see two types of areas: Geographic and Radius.
CensusCD Block ABLOCKS\NONAME RE
& o o

Select Geographic Area, or press the 22 button to display the geographic area screen:

There are 6 levels of geography that Blocks can be selected for:

Nation State
Region County
Division Tract

©2002 GeoLytics, Inc. Al rights reserved. Page 4 of 4 |
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Step 3B. Continued

The Geographic area screen will let you easily select blocks at any of the 6 geographic levels. Simply select
the geographic area you want from the pull down lists. If you only want Blocks for a specific tract within a
county that you have selected, see the description of the Filter function below.

You can select any area and up to 240 areas of the same type. For example, several states like Texas,
Arizona and Ohio or a number of Counties like Bronx, Kings, and Queens in New York could be selected.

For example:

Lets pick Manhattan as the area we want Block information for. To select Manhattan (New York County) as the
area, we would:

(1) Select the menu item AREA

(2) Select GEOGRAPHIC AREA from the pull-down list that will appear

(3) Select Counties as the Geographic Area

(4) In the Geographic Areas window that will appear, select NEW YORK as the state
(5) Select NEW YORK as the county as well

(6) Select DONE

% Geographic Area:  Counties
SRR o o

NY. Monroe County
NY. Montgomery County
NY. Massau County

NY. New York County
NY. Niagara County
NY. Oneida County
NY. Onondaga County
NY. Dntario County
INY. Orange County
NY, Orleans County
NY. Oswego County
NY. Otsego County

CCETRRERT
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Step 3B. Continued

The second type of area is &2 Radius (circular area). You may decide to use this type of area view to get
information for what's around a specific location. Use an exact Latitude and Longitude to specify the cen-

ter of the Radius. Then, enter the distance from the center of the radius to specify the radial area size (for
example, 20 miles from a specific location).

=

©2002 Geolytics, Inc. All rights reserved.
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Step 3C. Selection of Counts to be Included

Next, specify census counts to include in your file. In other words, “what information are you interested in?”
Counts are the actual block demographic and block geographic identification data that you want to
know.

Any of the 3000+ counts available can be selected using % counts. See the Appendix for descrip-

tions of all data tables.

Selecting Demographics:
Lets pick Mean Housing Value as the demographic information we want for each Block:

(1) Select the menu item COUNTS

(2) Select the group you want; Geographic Identifiers, Pop, and Household

(3) In the window that appears with all demographics, scroll down and select the demographics you want
(4) Select DONE

While in the tailored counts screen, simply select the demographics you want. You know a count is selected
when you see its short description in the “selected” window. Tagging the first and last counts in this series and
then tagging the "Select Between" button can select a series of counts.

Searching for Geographic Areas and Counts:

There are search functions that will help you to find the geographic areas you are looking for or the demo-
graphics you are looking for. Both will search through the complete lists of areas, or counts, and return a list
that matches the search word you entered.

©2002 Geolytics, Inc. All rights reserved. Page 7 of 7 [
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Step 3D. Running and Viewing the file

t The last step is to run the file. First, choose Summary ASCII, .DBF, or Map.

For example, lets map it:
(1) Select the menu item RUN
(2) Select MAP

SR

The file run is done in a multitasking mode so that you can go on selecting other files, or doing other tasks,
while the system continues to access the database for the information you requested. When the file is com-
pleted, a viewer/map window will be created and activated, ar file will be displayed or mapped.

©2002 Geolytics, Inc. All rights reserved.
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You can view any file using the CensusCD 2000 Short Form Blocks viewer. While browsing the file, you can search for
information, copy to clipboard, or print the file.

Finally, you can use the file data as an input to other systems like statistical (e.g. SAS, SPSS), database (e.g.
Access, Oracle), spreadsheet (e.g. Excel, 1-2-3), or mapping (e.g. ArcView, Maplnfo) packages.

©2002 Geolytics, Inc. All rights reserved.
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4. Using the Map Viewer

Within the Map Viewer you can change data themes, ranges, and color schemes on the fly. It allows you to
print your map with options to save it as a .bmp file, which can be imported or pasted into most word proc-
essing, spreadsheet, and graphics packages. CensusCD 2000 Short Form Blocks also lets you export
boundaries and data in desktop mapping formats (ArcView or Maplinfo). There is even a variable calculator
for creating and displaying virtual variables based on data in your file.

HINT: You can even use the Map Viewer to display your own .DBF data files if you have a Geographic key
column (15 digit character) which lets the program match Geographic boundaries to your data records. See
the Map Guide under Help for more information on how to display your own .DBF files.

Open Open Zoom Zoom
Report Boundary Print Info Scale Scale Value In Out Center Pan Enlarge Formulas Tabs
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Area Selection Home button

A specific help section to explain the map viewer is available from both the main help contents and the
Map Viewer itself.

©2002 Geolytics, Inc. Al rights reserved. Page 10 of 10 l
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5. Help

CensusCD 2000 Short Form Blocks contains extensive on-line help. On the main menu, select help. Un-
der help select “contents”. You may rely on “automatic advice” located on the bottom of the screen for “next
step” prompting. Placing the focus on the item in question, and pressing the F1 key can also request help.

The on-line help contains additional information about selecting, mapping, and exporting Geographic data and
boundaries. Documentation provided by the creators of the data compiled into CensusCD 2000 Short Form
Blocks is also included. A specific help section to explain the map viewer is available from both the main help
contents and the Map Viewer itself.

6. Contacting GeolLytics, Inc.

Web Site: http://www.Geolytics.com
E-Mail: info@Geolytics.com

Sales & Customer Support: 1-800-577-6717

Tech Support: support@Geolytics.com
Fax: 1-732-651-2721
Mail: Geolytics, Inc.

PO Box 10

East Brunswick, NJ 08816

©2002 Geolytics, Inc. All rights reserved. [ Page11of11 |
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Appendix. CensusCD 2000 Short Form Blocks Data

Tables

Short Name Description

GEOID GEOGRAPHIC IDENTIFIERS

PO01 TOTAL POPULATION

P002 URBAN AND RURAL

P0O03 RACE

P004 HISPANIC AND NOT HISPANIC BY RACE
P0O05 RACE FOR POP 18+

P006 HISPANIC AND NOT HISPANIC BY RACE FOR POP 18+
P0OQ7 RACE

P008 HISPANIC BY RACE

P009 RACE (TOTAL RACES TALLIED)

PO10 HISPANIC BY RACE (TOTAL RACES TALLIED)
PO11 HISPANIC

P012 SEX BY AGE

P013 MEDIAN AGE BY SEX (1 DEC)

P014 SEX BY AGE FOR POP UNDER 20 YEARS

PO15 HOUSEHOLDS

PO16 POP IN HHS
PO17 AVG HH SIZE (2 DEC)

P018 HH SIZE,HH TYPE,AND PRESENCE OF OWN CHILDS

PO19 HHS BY PRESENCE OF PEOPLE 0-17 BY HH TYPE

P020 HHS BY AGE OF HHER BY HH TYPE (INC LIVING ALONE) BY PRESENCE OF OWN CHILDS
P021 HH TYPE BY AGE OF HHER

P022 HHS BY PRESENCE OF PEOPLE 60+ ,HH SIZE, & HH TYPE

P023 HHS BY PRESENCE OF PEOPLE 65+ ,HH SIZE, & HH TYPE

P024 HHS BY PRESENCE OF PEOPLE 75+ , HH SIZE, & HH TYPE
P025 HHS BY PRESENCE OF NONRELATIVES

P026 HH TYPE BY HH SIZE

pP027 RELATIONSHIP BY HH TYPE (INC LIVING ALONE)

P028 RELATIONSHIP BY HH TYPE FOR POP 0-17

P029 RELATIONSHIP BY AGE FOR POP 0-17

P0O30 RELATIONSHIP BY HH TYPE (INC LIVING ALONE) FOR POP 65+
PO31 FAMILIES

P032 POP IN FAMILIES

P0O33 AVG FAMILY SIZE (2 DEC)

P034 FAMILY TYPE BY PRESENCE & AGE OF OWN CHILDS

P035 FAMILY TYPE BY PRESENCE & AGE OF RELATED CHILDS

P036 OWN CHILDS 0-17 BY FAMILY TYPE & AGE

P037 GROUP QUARTERS POP BY GROUP QUARTERS TYPE

F038 GROUP QUARTERS POP BY SEX BY AGE BY GROUP QUARTERS TYPE
P039 POP SUBSTITUTED

P040 IMPUTATION OF POP ITEMS

P041 IMPUTATION OF RACE

P042 IMPUTATION OF HISPANIC

P043 IMPUTATION OF SEX

P044 IMPUTATION OF AGE

P045 IMPUTATION OF RELATIONSHIP

PO12A SEX BY AGE (WHITE ALONE)
PO12B SEX BY AGE (BLACK ALONE)
pOl2cC SEX BY AGE (NATIVE AMERICAN ALONE)

©2002 Geolytics, Inc. All rights reserved.
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P012D
PO12E
PO12F
P012G
PO12H
P0121I
PO13A
PO13B
P013C
P013D
PO13E
POL13F
P013G
PO13H
P013I
PO15A
PO15B
P015C
PO15D
POL5E
POL5F
P015G
PO15H
PO15I
POL6A
PO16B
PO16C
PO16D
POL6E
POL6F
P016G
POL6H
PO16I
POL7A
PO17B
PO17C
PO17D
PO17E
POL7F
PO17G
PO17H
POL17I
P026A
P026B
P026C
P026D
PO26E
PO26F
P026G
P026H
P0261I
PO27A
P027B
P027C
P027D
PO27E
PO27F
P027G
P027H
P0271
P028A
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SEX BY AGE (ASIAN ALONE)

SEX BY AGE (PACIFIC ISLANDER ALONE)

SEX BY AGE (SOME OTHER RACE ALONE)

SEX BY AGE (TWO OR MORE RACES)

SEX BY AGE (HISPANIC)

SEX BY AGE (WHITE ALONE, NOT HISPANIC)

MEDIAN AGE BY SEX (WHITE ALONE) (1 DEC)

MEDIAN AGE BY SEX (BLACK ALONE) (1 DEC)

MEDIAN AGE BY SEX (NATIVE AMERICAN ALONE) (1 DEC)
MEDIAN AGE BY SEX (ASIAN ALONE) (1 DEC)

MEDIAN AGE BY SEX (PACIFIC SLANDER ALONE) (1 DEC)
MEDIAN AGE BY SEX (SOME OTHER RACE ALONE) (1 DEC)
MEDIAN AGE BY SEX (TWO OR MORE RACES) (1 DEC)
MEDIAN AGE BY SEX (HISPANIC) (1 DEC)

MEDIAN AGE BY SEX (WHITE ALONE, NOT HISPANIC) (1 DEC)
HHS (WHITE ALONE HHER)

HHS (BLACK ALONE HHER)

HHS (NATIVE AMERICAN ALONE HHER)

HHS (ASIAN ALONE HHER)

HHS (PACIFIC ISLANDER ALONE HHER)

HHS (SOME OTHER RACE ALONE HHER)

HHS (2+ RACES HHER)

HHS (HISPANIC HHER)

HHS (WHITE ALONE, NOT HISPANIC HHER)

POP IN HHS (WHITE ALONEHHER)

POP IN HHS (BLACK ALONE HHER)

POP IN HHS (NATIVE AMERICAN ALONE HHER)

POP IN HHS (ASIAN ALONE HHER)

POP IN HHS (PACIFIC ISLANDER ALONE HHER)

POP IN HHS (SOME OTHER RACE ALONE HHER)

POP IN HHS (TWO OR MORE RACES HHER)

POP IN HHS (HISPANIC HHER)

POP IN HHS (WHITE ALONE, NOT HISPANIC HHER)

AVG HH SIZE (WHITE ALONE HHER) (2 DEC)

AVG HH SIZE (BLACK ALONE HHER) (2 DEC)

AVG HH SIZE (NATIVE AMERICAN ALONE HHER) (2 DEC)
AVG HH SIZE (ASIAN ALONE HHER) (2 DEC)

AVG HH SIZE (PACIFIC ISLANDER ALONE HHER) (2 DEC)
AVG HH SIZE (SOME OTHER RACE ALONE HHER) (2 DEC)
AVG HH SIZE (TWO OR MORE RACES HHER) (2 DEC)

AVG HH SIZE (HISPANIC HHER) (2 DEC)

AVG HH SIZE (WHITE ALONE, NOT HISPANIC HHER) (2DECS)

HHYTYPE BY HH
HH TYPE BY HH
HEGTYERS BYHH
HH TYPE BY HH
HH TYPE BY HH
HH TYEE BY HH
HH TYPE BY HH
HH TYPE BY HH
HHSTYPFSBY S HH
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP
RELATIONSHIP

SIZE
SIZE
SIZE
SIZE
SIZE
SIZE
SIZE
SIZE
SIZE

BY
BY
BY
BY
BY
BY
BY
BY
BY
BY

©2002 Geolytics, Inc. All rights reserved.

HH
HH
HH
HH
HH
HH
HH
HH
HH
HH

(WHITE ALONE HHER)

(BLACK ALONE HHER)

(NATIVE AMERICAN ALONE HHER)
(ASIAN ALONE HHER)

(PACIFIC ISLANDER ALONE HHER)
(SOME OTHER RACE ALONE HHER)
(TWO OR MORE RACES HHER)
(HISPANIC HHER)
(WHITE ALONE, NOT HISPANIC HHER)

TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE

(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING
(INC LIVING

FOR POP 0-17

ALONE) (WHITE ALONE)

ALONE) (BLACK ALONE)

ALONE) (Native American ALONE)
ALONE) (ASIAN ALONE)

ALONE) (PACIFIC ISLANDER ALONE)
ALONE) (SOME OTHER RACE ALONE)
ALONE) TWO OR MORE RACES)

ALONE) (HISPANIC)

ALONE) (WHITE ALONE, NOT HISPANIC)

(WHITE ALONE)
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P028B
P028C
P028D
PO28E
PO28F
P028G
P028H
P028I
PO30A
PO30B
P030C
P030D
PO30E
PO30F
P030G
PO30H
P030I
PO31A
PO31B
P031C
P031D
PO31E
PO31F
P031G
PO31H
PO31I
P032A
P032B
P032C
P032D
PO32E
PO32F
P032G
P032H
P032I
P033A
P033B
P033C
P033D
PO33E
PO33F
P033G
PO33H
PO331I
PO34A
P034B
P034C
P034D
PO34E
PO34F
P034G
PO34H
P0341
P0O35A
P035B
P035C
PO35D
PO35E
PO35F
P035G
PO35H

FAMILIES
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RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY
RELATIONSHIP BY

FAMILIES (B

FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES

POP
POP
POP
POP
POP
POP
POP
POP
POP
AVG
AVG
AVG
AVG
AVG
AVG
AVG
AVG
AVG

IN
IN
IN
IN
IN
IN
IN
IN
IN

(WHITE

LACK

FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILIES
FAMILY SIZE
FAMILY SIZE
FAMILY SIZE
FAMILYSIZE (ASIAN ALONE HHER) (2 DEC)
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
FAMILY
©2002 Geolytics, Inc. All rights reserved.

TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
T PE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE
TYPE

SIZE
SIZE
SIZE
SIZE
SIZE
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY
BY

HH TYPE FOR POP 0-17 (BLACK ALONE)

HH TYPE FOR POP 0-17 (NATIVE AMERICAN ALONE)

HH TYPE FOR POP 0-17 (ASIAN ALONE)

HH TYPE FOR POP 0-17 (PACIFIC ISLANDER ALONE)

HH TYPE FOR POP 0-17 (SOME OTHER RACE ALONE)

HH TYPE FOR POP 0-17 (TWO OR MORE RACES)

HH TYPE FOR POP 0-17 YEARS (HISPANIC)

HH TYPE FOR POP 0-17 (WHITE ALONE, NOT HISPANIC)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (WHITE ALONE)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (BLACK)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (NATIVE AMERICAN)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (ASIAN ALONE)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (PACIFIC ISLANDER)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (SOME OTHER RACE ALONE)
HH TYPE (INC LIVING ALONE) FOR POP 65+ (TWO OR MORE RACES)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (HISPANIC)

HH TYPE (INC LIVING ALONE) FOR POP 65+ (WHITE ALONE, NOT HISPANIC)
ALONE HHER)

ALONE HHER)

(NATIVE AMERICAN ALONE HHER)
(ASIAN ALONE HHER)

(PACIFIC ISLANDER ALONE HHER)
(SOME OTHERRACE ALONEHHER)

(TWO OR MORE RACES HHER)
(HISPANIC HHER)

(WHITE ALONE, NOT HISPANIC HHER)

(WHITE ALONE HHER)

(BLACK ALONE HHER)

(NATIVE AMERICAN ALONE HHER)
(ASIAN ALONE HHER)

(PACIFIC ISLANDER ALONE HHER)
(SOME OTHER RACE ALONE HHER)
(TWO OR MORE RACES HHER)
(HISPANIC HHER)

(WHITE ALONE,NOT HISPANIC HHER)
(WHITE ALONE HHER) (2 DEC)
(BLACK ALONE HHER) (2 DEC)
(NATIVE AMERICAN ALONE HHER) (2 DEC)

(PACIFIC ISLANDER ALONE HHER) (2 DEC)

(SOME OTHER RACE ALONE HHER) (2 DEC)

(TWO OR MORE RACES HHER) (2 DEC)

(HISPANIC HHER) (2 DEC)

(WHITE ALONE,NOT HISPANIC HHER) (2 DEC)
PRESENCE & AGE OF OWN CHILDS (WHITE ALONE HHER)

PRESENCE & AGE OF OWN CHILDS (BLACK ALONE HHER)

PRESENCE & AGE OF OWN CHILDS (NATIVE AMERICAN ALONE HHER)
PRESENCE & AGE OF OWN CHILDS (ASIAN ALONE HHER)

PRESENCE & AGE OF OWN CHILDS (PACIFIC ISLANDER ALONE HHER)
PRESENCE & AGE OF OWN CHILDS (SOME OTHER RACE ALONE HHER)
PRESENCE & AGE OF OWN CHILDS (TWO OR MORE RACES HHER)
PRESENCE & AGE OF OWN CHILDS (HISPANIC HHER)

PRESENCE & AGE OF OWN CHILDS (WHITE ALONE, NOT HISPANIC HHER)
PRESENCE & AGE OF RELATED CHILDS (WHITE ALONE HHER)

PRESENCE & AGE OF RELATED CHILDS (BLACK ALONE HHER)

PRESENCE & AGE OF RELATED CHILDS (NATIVE AMERICAN ALONE HHER)
PRESENCE & AGE OF RELATED CHILDS (ASIAN ALONE HHER)

PRESENCE & AGE OF RELATED CHILDS (PACIFIC ISLANDER ALONE HHER)
PRESENCE & AGE OF RELATED CHILDS (SOME OTHER RACE ALONE HHER)
PRESENCE & AGE OF RELATED CHILDS (TWO OR MORE RACES HHER)
PRESENCE & AGE OF RELATED CHILDS (HISPANIC HHER)
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P035I
HOO1
H002
HOO03
H004
HOO05
HO06
HOO7
HOO08
HO0S9
HO10
HO11
HO12
HO13
HO14
HO15
HO1l6
HO17
HO18
HO19
HO020
HO11lA
HO11B
HOllc
HO11D
HO1l1lE
HOLllF
HO11G
HO11lH
HO11lI
HO12A
HO12B
HO1l2C
HO12D
HO12E
HO12F
HO12G
HO12H
HO12I
HO15A
HO15B
HO15C
HO15D
HO15E
HO15F
HO15G
HO15H
HO015I
HO1l6A
HO16B
HO16C
HO16D
HO1l6E
HO1l6F
HO16G
HO16H
HO16I

FAMILY TYPE BY PRESENCE & AGE OF RELATED CHILDS (WHITE ALONE, NOT HISPANIC HHER)
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HOUSING UNITS (HU)
URBAN AND
OCCUPANCY STATUS

TENURE

RU

RAL

VACANCY STATUS
RACE OF HHER
HISPANIC HHER BY RACE OF HHER

TOTAL RACES TALLIED FOR HHERS
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